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Introduction 
ToolsToo is an add-in for Microsoft Office PowerPoint 2010 (ToolsToo Lite is compatible with Microsoft 

Office PowerPoint 2007/2010) that enhances the PowerPoint presentation software with many 

powerful, yet easy to use, editing productivity tools. 

The idea for ToolsToo originated in the difficulty of aligning shapes using the standard features within 

the PowerPoint software. When using these alignment features, the PowerPoint software looks at all 

the selected shapes as a group and performs the desired operation across the entire group. So, for 

example, if you center align, the PowerPoint software moves all of the shapes to the center of the whole 

group. In most cases this behavior is not very useful as one or more of the shapes that are moved were 

probably already carefully positioned. ToolsToo addresses this by enabling you to specify a Reference 

Shape and align other shapes according to this Reference Shape. Once this capability was developed, 

many other opportunities to improve slide-making became evident, resulting in a wide array of tools. 

Together, these tools eliminate much of the drudgery of building effective slides. 

The current version of ToolsToo includes the following editing productivity tools: 

Feature ToolsToo ToolsToo Lite 

Define the presentation space for each slide layout √  

Adjoin selected shapes edge to edge √  

Align edges of selected shapes according to the Reference Shape √  

Align selected shapes according to the Reference Shape √ √ 

Distribute selected shapes horizontally or vertically within the 
Reference Shape 

√  

Size selected shapes according to the Reference Shape √ √ 

Size (width, height) selected shapes according to the Reference Shape 
while optionally preserving aspect ratio 

√  

Format selected shapes according to the Reference Shape √ √ 

Format (crop, shadow, reflection, bevel, rotation) selected shapes 
according to the Reference Shape 

√  

Animate selected shapes according to the Reference Shape √  

Assign z-order to the selected shapes in the order they were selected √  

Resequence animation and optionally stagger the animation √  

Select text to become the slide title √  

Add connection sites to a shape √  

Paste an image from the clipboard, scale for best fit, and center √  

Make lines horizontal or vertical √  

Copy agenda slides and show progression within the presentation √  

Extract selected slides √  

Extract notes to a Microsoft Word document √  

Split text between two slides √  

Remove all animation √  

Remove all notes √  
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Feature ToolsToo ToolsToo Lite 

Remove all hidden slides √  

Show slide statistics for the current presentation  √ 

Show slide statistics and estimated duration for the current 
presentation 

√  

Standard Microsoft PowerPoint Drawing group from the Home tab 
included in the ToolsToo tab 

√ √ 

For ease of use, ToolsToo is implemented as a tab within the PowerPoint ribbon: 

 

Figure  ToolsToo Ribbon 

 

Figure  ToolToo Lite Ribbon 

Many users have reported that ToolsToo is so powerful and productive that once they have used it, they 

find it difficult to create PowerPoint presentations without it. 

Basic Concepts: The Reference Shape and Presentation Space 
Many of the tools within ToolsToo use a Reference Shape as the basis for their function: when aligning 

left, for example, the selected shapes are aligned according to the left side of the Reference Shape. The 

Reference Shape can be either the first shape selected or a predetermined presentation area called 

Presentation Space that is typically used to indicate the region of the slide to be used for its content. The 

user specifies which to use as the Reference Shape via the Relative to Presentation Space option in the 

Options group in the ToolsToo ribbon: 

When Relative to Presentation Space is not selected, the Reference Shape is the first shape selected. 

When Relative to Presentation Space is selected, the Reference Shape is the Presentation Space defined 

in the current slide’s master layout. 

Note: the Presentation Space feature is not available in ToolsToo Lite. 
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Defining the Presentation Space 
In order to use the Presentation Space feature, it is first necessary to define the Presentation Space for 

each master slide layout. Perform the following steps: 

1. On the View tab, select Slide Master in the Master Views group 

2. For each layout, add a shape to represent the desired Presentation Space: 

a. Position it and size it as appropriate 

b. Right-click the shape, select Format Shape…, then select Alt Text. Specify the Description 

as “ToolsToo_PS”

 

Figure  Specifying the Alternative Text for the Presentation Space 

c. Make the shape invisible: 

i. Delete any text in the shape 

ii. Set the Shape Fill to No Fill 

iii. Set the Shape Outline to No Outline 

iv. Send the shape to the back 

Note: the Presentation Space feature is not available in ToolsToo Lite. 
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Shape Tools 
These tools are used to manipulate shapes on an individual slide in relation to one another, and occupy 

the first six groups in the ToolsToo ribbon and the first two groups in the ToolsToo Lite ribbon. 

Adjoin 
The Adjoin tools move the selected shapes, either horizontally or vertically, so that the edge of each 

shape aligns with the opposite edge of the preceding selected shape. The Reference Shape (see Basic 

Concepts: The Reference Shape and Presentation Space above) is not moved. 

 

Figure  The Adjoin Group in the ToolsToo Ribbon 

In the example below, the three shapes are selected in numerical order and shape 1 is the Reference 

Shape. When Adjoin Bottom to Top is clicked, shape 2 is moved vertically so that its top aligns with the 

bottom of shape 1 and then shape 3 is moved vertically so that its top aligns with the bottom of shape 2 

in its new location. 
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Figure  Before Adjoin Bottom to Top 

 

Figure  After Adjoin Bottom to Top 
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Adjoin Left to Right ( ) 

Moves the selected shapes horizontally so that the right edge of each shape lines up with the left edge 

of the preceding selected shape. The Reference Shape is not moved. 

Adjoin Right to Left ( ) 

Moves the selected shapes horizontally so that the left edge of each shape lines up with the right edge 

of the preceding selected shape. The Reference Shape is not moved. 

Adjoin Top to Bottom ( ) 

Moves the selected shapes vertically so that the bottom edge of each shape lines up with the top edge 

of the preceding selected shape. The Reference Shape is not moved. 

Adjoin Bottom to Top ( ) 

Moves the selected shapes vertically so that the top edge of each shape lines up with the bottom edge 

of the preceding selected shape. The Reference Shape is not moved. 

Align Edge 
The Align Edge tools resize the selected shapes so that the edge of each shape aligns with the matching 

edge of the Reference Shape (see Basic Concepts: The Reference Shape and Presentation Space above). 

Unlike the Align Shape alignment tools, the selected shapes are not moved. 

 

Figure  The Align Edge Group in the ToolsToo Ribbon 

In the example below, the three shapes are selected in numerical order and shape 1 is the Reference 

Shape. When Align Right Edge is clicked, shape 2 is resized so that its right edge is aligned with the right 

edge of the shape 1 and then the same is done with shape 3. Since the Lock Aspect Ratio option is not 

selected, the heights of shapes 2 and 3 are not modified. 
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Figure  Before Align Right Edge 

 

Figure  After Align Right Edge 
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Align Left Edge ( ) 

Resizes the selected shapes so that the left edge of each shape aligns with the left edge of the Reference 

Shape. If the Lock Aspect Ratio option is selected, the heights of the selected shapes will also be changed 

to maintain each shape’s aspect ratio. 

ü If the Lock Aspect Ratio option is not selected, this tool may distort the selected shapes. 

Align Right Edge ( ) 

Resizes the selected shapes so that the right edge of each shape aligns with the right edge of the 

Reference Shape. If the Lock Aspect Ratio option is selected, the heights of the selected shapes will also 

be changed to maintain each shape’s aspect ratio. 

ü If the Lock Aspect Ratio option is not selected, this tool may distort the selected shapes. 

Align Top Edge ( ) 

Resizes the selected shapes so that the top edge of each shape aligns with the top edge of the Reference 

Shape. If the Lock Aspect Ratio option is selected, the widths of the selected shapes will also be changed 

to maintain each shape’s aspect ratio. 

ü If the Lock Aspect Ratio option is not selected, this tool may distort the selected shapes. 

Align Bottom Edge ( ) 

Resizes the selected shapes so that the bottom edge of each shape aligns with the bottom edge of the 

Reference Shape. If the Lock Aspect Ratio option is selected, the widths of the selected shapes will also 

be changed to maintain each shape’s aspect ratio. 

ü If the Lock Aspect Ratio option is not selected, this tool may distort the selected shapes. 
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Align Shape 
The Align Shape tools move or distribute the selected shapes. The alignment tools move the selected 

shapes, either horizontally or vertically, so that the edge or center of each shape aligns with the 

matching edge or center of the Reference Shape (see Basic Concepts: The Reference Shape and 

Presentation Space above). Unlike the Align Edge tools, the Align Shape alignment tools move the 

selected shapes. The distribution tools distribute the selected shapes, either horizontally or vertically, 

within the Reference Shape, so that the empty space is distributed evenly. The Reference Shape is not 

moved. 

  

Figure  The Align Shape Group in the ToolsToo Ribbon Figure  The Align Shape Group in the ToolToo Lite Ribbon 

In the example below, the three shapes are selected in numerical order and shape 1 is the Reference 

Shape. When Align Shape Center is clicked, shape 2 is moved horizontally so that its horizontal center 

aligns with the horizontal center of shape 1 and then the same is done with shape 3. 

In Figure , the blue shape is selected first, followed by the three yellow shapes in numerical order. The 

blue shape is the Reference Shape. When Distribute Vertically is clicked, the three yellow shapes are 

moved vertically within the Reference Shape so that the four empty spaces above, in between, and 

below the three yellow shapes are all equal in size. 
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Figure  Before Align Shape Center 

 

Figure  After Align Shape Center 
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Figure  Before Distribute Vertically 

 

Figure  After Distribute Vertically 
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Align Shape Center and Middle ( ) 

Moves the selected shapes so that the center of each shape aligns with the center of the Reference 

Shape. The Reference Shape is not moved. 

Align Shape Left ( ) 

Moves the selected shapes horizontally so that the left edge of each shape aligns with the left edge of 

the Reference Shape. The Reference Shape is not moved. 

Align Shape Center ( ) 

Moves the selected shapes horizontally so that the horizontal center of each shape aligns with the 

horizontal center of the Reference Shape. The Reference Shape is not moved. 

Align Shape Right ( ) 

Moves the selected shapes horizontally so that the right edge of each shape aligns with the right edge of 

the Reference Shape. The Reference Shape is not moved. 

Distribute Horizontally ( ) 

Distributes the selected shapes horizontally within the Reference Shape so that the empty space is 

distributed evenly. The Reference Shape is not moved. 

Align Shape Top ( ) 

Moves the selected shapes vertically so that the top edge of each shape aligns with the top edge of the 

Reference Shape. The Reference Shape is not moved. 

Align Shape Middle ( ) 

Moves the selected shapes vertically so that the vertical middle of each shape aligns with the vertical 

middle of the Reference Shape. The Reference Shape is not moved. 

Align Shape Bottom ( ) 

Moves the selected shapes vertically so that the bottom edge of each shape aligns with the bottom edge 

of the Reference Shape. The Reference Shape is not moved. 

Distribute Vertically ( ) 

Distributes the selected shapes vertically within the Reference Shape so that the empty space is 

distributed evenly. The Reference Shape is not moved. 
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Make Same 
The Make Same tools make the size or formatting of the selected shapes the same as that of the 

Reference Shape (see Basic Concepts: The Reference Shape and Presentation Space above). 

  

Figure  The Make Same Group in the ToolsToo Ribbon Figure  The Make Same Group in the ToolsToo Lite Ribbon 

In the example below, the three shapes are selected in numerical order and shape 1 is the Reference 

Shape. When Make Same Width is selected, the widths of shapes 2 and 3 are set to the width of shape 

1. Since the Lock Aspect Ratio option is not selected, the heights of shapes 2 and 3 are not modified. 
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Figure  Before Make Same Width 

 

Figure  After Make Same Width 
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Make Same Width ( ) 

Makes the width of the selected shapes the same as that of the Reference Shape. If the Lock Aspect 

Ratio option is selected, the heights of the selected shapes will also be changed to maintain each 

shape’s aspect ratio. 

ü If the Lock Aspect Ratio option is not selected, this tool may distort the selected shapes. 

Make Same Height ( ) 

Makes the height of the selected shapes the same as that of the Reference Shape. If the Lock Aspect 

Ratio option is selected, the widths of the selected shapes will also be changed to maintain each shape’s 

aspect ratio. 

ü If the Lock Aspect Ratio option is not selected, this tool may distort the selected shapes. 

Make Same Size ( ) 

Makes the size (both width and height) of the selected shapes the same as that of the Reference Shape. 

Make Same Crop ( ) 

Makes the cropping of the selected shapes the same as that of the Reference Shape. 

ü Cropping can be applied only to pictures and OLE objects. All other objects are ignored. 

Make Same Shadow ( ) 

Makes the shadow of the selected shapes the same as that of the Reference Shape. 

Make Same Reflection ( ) 

Makes the reflection of the selected shapes the same as that of the Reference Shape. 

Make Same Bevel ( ) 

Makes the bevel of the selected shapes the same as that of the Reference Shape. 

Make Same Rotation ( ) 

Makes the rotation of the selected shapes the same as that of the Reference Shape. 

ü Make Same Rotation calculates the actual rotation of a line instead of using the reported 

rotation.  

Make Same Format ( ) 

Makes the format of the selected shapes the same as that of the Reference Shape. 

Make Same Animation ( ) 

Makes the animation of the selected shapes the same as that of the Reference Shape. 
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Order 
The Order tools alter the front-to-back sequence or the animation sequence of the selected shapes. The 

Reference Shape (see Basic Concepts: The Reference Shape and Presentation Space above) is not 

resequenced. 

 

Figure  The Order Group in the ToolsToo Ribbon 

In the example below, the initial order from front-to-back is 2-1-4-3. Shapes 1 – 3 are selected in 

numerical order and shape 1 is the Reference Shape. When Send Backward is selected, shape 2 is placed 

behind shape 1 and then shape 3 is placed behind shape 2. The resulting front-to-back order is 1-2-3-4. 
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Figure  Before Send Backward 

 

Figure  After Send Backward 
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Bring Forward ( ) 

Alters the front-to-back sequence of the selected shapes so that each shape is placed immediately in 

front of the preceding selected shape. The Reference Shape is not resequenced. 

Send Backward ( ) 

Alters the front-to-back sequence of the selected shapes so that each shape is placed immediately 

behind the preceding selected shape. The Reference Shape is not resequenced. 

Animation Resequence ( ) 

Alters the animation sequence of the selected shapes so that the first animation effect for each shape is 

placed immediately after that of the preceding selected shape. The first animation effect for the 

Reference Shape is not resequenced. If the Reference Shape does not have any animation effects, the 

resequenced animation for the selected shapes starts at the beginning of the overall animation 

sequence. 

Stagger Animation 

When Stagger Animation is selected, the Animation Resequence tool also changes the effects for 

all selected shapes (except that of the Reference Shape) to "With Previous" and evenly 

distributes the Delay time among all the selected effects. This  results in what is sometimes 

referred to as an "animation waterfall". 

For example, if 4 shapes (including the Reference Shape) are selected, the first Reference Shape 

effect has a Delay of 0 seconds, and the first effect for the last selected shape has a Delay of 0.9 

seconds, then the Delay for the first effect of the second shape is set to 0.3 seconds, and the 

Delay for the first effect of the third shape is set to 0.6 seconds. 

Options 

 

Figure  The Options Group in the ToolsToo Ribbon 

Relative to Presentation Space 

 When Relative to Presentation Space is selected, the Reference Shape (see Basic Concepts: The 

Reference Shape and Presentation Space above) is the Presentation Space defined in the current slide’s 

master layout. 

When Relative to Presentation Space is not selected, the Reference Shape is the first shape selected. 
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Lock Aspect Ratio 

When Lock Aspect Ratio is selected, the widths of shapes changed with the Make Same Height tool and 

the heights of shapes changed with the Make Same Width tool are also changed such that each shape’s 

original aspect ratio is preserved. 

When Lock Aspect Ratio is not selected, the Make Same Height tool changes only the heights of the 

selected shapes and the Make Same Width tool changes only the widths of the selected shapes. The 

aspect rations are not preserved and the shapes may be distorted. 

General Tools 
These tools are a collection of useful functions, some at the individual shape level, some at the 

individual slide level, and many at the presentation level, to help in the preparation of professional 

presentations. 

  

Figure  The Tools Group in the ToolsToo Ribbon Figure  The Tools Group in the ToolsToo Lite Ribbon 

Make Title ( ) 
If text is selected, that text becomes the slide title. 

If a textbox is selected, its text becomes the slide title and the textbox is deleted. 

If any other shape is selected, any text in that shape becomes the slide title. 

Add Connection Sites ( ) 
Most of the shapes in Microsoft PowerPoint have an inadequate set of connection sites: rectangular 

shapes, for example, have only 4, one in the middle of each side. 

The Add Connection Sites tool draws an invisible freeform rectangle around each of the selected shapes 

and then groups each shape with its freeform. The result is 16 connection sites per shape: one in each 

corner of the freeform rectangle and 3 evenly spaced along each side of the freeform rectangle. 

ü When using Elbow Connectors or Curved Connectors to connect to shapes that have had 

connection sites added to them, the PowerPoint software will in certain circumstances route the 

connector through the shapes instead of around them. This behavior appears to be a bug in the 

PowerPoint software that has not been corrected as of Microsoft Office PowerPoint 2010 

Service Pack 1. 
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Insert Picture from Clipboard ( ) 
Inserts a new slide after the current one and pastes the contents of the clipboard, typically an image, 

such that they are scaled to fit the slide and centered. 

Make Line Horizontal ( ) 
Sets the height of selected lines to 0, making them horizontal. 

ü The primary use of this tool is to force lines that are nearly horizontal to actually be horizontal. 

Make Line Vertical ( ) 
Sets the width of selected lines to 0, making them vertical. 

ü The primary use of this tool is to force lines that are nearly vertical to actually be vertical. 

Copy Agenda Slide ( ) 
Agenda slides are those slides whose title matches the value set in the Set Agenda Title option (initially 

set to “Agenda”). 

The Reference Agenda Slide is the current slide if it is an agenda slide or the first agenda slide otherwise. 

The Copy Agenda Slide tool copies the Reference Agenda Slide to all other agenda slides and indicates 

progress through the presentation by dimming all but the current topic of each successive agenda slide. 

An agenda topic may have sub-topics. When the Copy Agenda Slide tool encounters a topic with sub-

topics, it highlights the first level topic along with each one of the sub-topics. 

The current topic is displayed in the Text 1 color from the slide’s theme colors and is bolded. The rest of 

the text is dimmed to the color chosen in the Set Dimmed Agenda Text Color option. 

Title slides and section header slides are considered placeholders for agenda slides and result in 

advancement of the progress indication. This feature can be disabled by setting the Ignore Title Slides 

option. 

Set Agenda Title ( ) 

Sets the title text used for agenda slides. 

Set Dimmed Agenda Text Color ( ) 

Displays a standard Windows color dialog to set the dimmed agenda text color. 

You can define and save up to 16 custom colors. 

Ignore Title Slides 

When Ignore Title Slides is selected, title slides and section header slides have no impact on the 

Copy Agenda Slide tool. 
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When Ignore Title Slides is not selected, title slides and section header slides are considered 

placeholders for agenda slides and result in advancement of the progress indication. 

Extract Selected Slides ( ) 
Saves the selected slides to a new presentation. 

ü To ensure that what you see is what you get, Extract Selected Slides actually saves the entire 

presentation to the new presentation and then deletes all but the selected slides. The active 

presentation being edited will be the new one and any changes to the non-selected slides will be 

lost. 

Extract Notes ( ) 
Extracts all of the notes from the current presentation to a Microsoft Word document. 

The notes from each slide start on a new page and the title of the page is the slide number followed by 

the title of the slide. 

ü This feature requires Microsoft Word. 

Split Text Between Two Slides ( ) 
Inserts a copy of the current slide immediately after the current slide with the text in the current text 

box split such that any text above the cursor position remains in the first slide while any text starting 

from the beginning of the current line is moved to the second slide. All other text and graphics are 

replicated between the two slides.  

Remove Animation ( ) 
Removes all animation (both click sequence and triggered) and slide transitions from the current 

presentation. 

Remove Notes ( ) 
Removes all notes from the current presentation. 

Remove Hidden Slides ( ) 
Removes all hidden slides from the current presentation. 

Slide Statistics ( ) 
Displays statistics about the slides in the presentation and estimated presentation duration: 

¶ Displayed slides 

o Title slides 

o Agenda slides 

o Section header slides 

o Content slides (other displayed slides that do not meet any of the above criteria) 

¶ Hidden slides 
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¶ Slides with click sequence animation 

¶ Slides with triggered animation 

¶ Slides with transition effects 

¶ Slides with automatic transitions 

¶ Slides with notes 

¶ Sections 

¶ Total slides 

You can set a default time per slide (initially set to 2 minutes) in the Set Time per Slide tool. If the 

presentation has the “Use Timings” option selected in the Set Up group on the Slide Show tab  and the 

slide itself has an “Advance Slide After…” time set in Timing group on the Transitions tab, then in most 

cases, this Advance Time will be used, as described below: 

¶ Content slides – the Advance Time is used if applicable, or the default time otherwise 

¶ Agenda slides – the Advance Time is used if applicable and all of the agenda slides have an 

Advance Time set, or the default time is used just once for all agenda slides 

¶ Title slides/section headers – the Advance Time is used if applicable, or zero otherwise 

Set Time per Slide ( ) 

Sets the default time per slide. 

Help 

  

Figure  The Help Group in the ToolsTool Ribbon Figure  The Help Group in the ToolsToo Lite Ribbon 

User Guide ( ) 

Displays this User Guide. 

ü This feature requires Microsoft Word. 

About ToolsToo/ToolsToo Lite ( ) 
Displays version information about ToolsToo/ToolsToo Lite and contact information. 
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Drawing 

  

Figure  The Drawing Group in the ToolsToo and ToolsToo Lite Ribbons 

The standard Drawing group from the Home tab in the standard Microsoft PowerPoint ribbon. It is 

replicated in the ToolsToo ribbon to reduce the switching of ribbon tabs while working on slides. 

Limitations 
1. ToolsToo operates on native PowerPoint objects. Some features may not function on embedded 

external objects. 

2. ToolsToo treats an entire SmartArt graphic as one object and cannot manipulate the individual 

items within the SmartArt graphic, unless they are ungrouped to separate objects. 

Frequently Asked Questions 
1. If a presentation edited with ToolsToo is sent to someone else, do they need ToolsToo or 

ToolsToo Lite on their computer? 

No. ToolsToo and ToolsToo Lite are required only on the PC that is utilizing the ToolsToo or 

ToolsToo Lite productivity tools while editing a Microsoft PowerPoint presentation. 

2. If a presentation edited with ToolsToo is sent to someone else, do they need to enable macros 

or lower their security settings? 

No. The presentations created with the help of the ToolsToo or ToolsToo Lite productivity tools 

are no different than any other Microsoft PowerPoint presentation and no particular security 

settings are required. 

3. Do ToolsToo and ToolsToo Lite work with the 64-bit version of Microsoft PowerPoint 2010? 

No. ToolsToo and ToolsToo Lite currently work only with the 32-bit version of Microsoft 

PowerPoint 2010. ToolsToo Lite also works with Microsoft PowerPoint 2007. 
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Tips 
1. In order to precisely control the order in which shapes are selected, it is recommended to click 

to select the Reference Shape and then CTRL + click to select each of the other shapes. 

2. To easily add agenda slides to a presentation, create the first one with all of the details, then 

add blank agenda slides at the appropriate places throughout the presentation, and finally click 

on the Copy Agenda Slide tool. If you need to make changes to the agenda, simply change one of 

the agenda slides and while still positioned on the changed agenda slide, rerun the Copy Agenda 

Slide tool. 

Support 
If you have any suggestions for additional tools you would like to see or any support issues, please send 

an e-mail to support@toolstoo.com. 

Microsoft and PowerPoint are either registered trademarks or trademarks of Microsoft Corporation 

in the United States and/or other countries. 

mailto:support@toolstoo.com

